
Practice Senteces 

1. The quick brown fox jumps over the lazy dog. 

2. Now is the time for all good men to come to the aid of their country.  

3. Whenever the black fox jumped the squirrel gazed suspiciously. 

4. A mad boxer shot a quick, gloved jab to the jaw of his dizzy opponent. 

5. The public was amazed to view the quickness and dexterity of the 

juggler. 

6. Ebenezer unexpectedly bagged two tranquil aardvarks with his jiffy 

vacuum cleaner. 
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Every time we forget about Google's creepy side it goes and does something to 

remind us again. This week's reminder comes from Google's lawyers: in their battle 

against California's Consumer Watchdog over privacy, they said that anyone 

sending emails to Gmail users should have "no legitimate expectation of privacy."  

The publicity over this has been somewhat overblown, because Google has to scan 

the contents of emails: that's how it serves the ads, filters spam, enables you to 

search your archive and so on.  And the bit everybody's getting annoyed about 

refers to third parties, not Gmail customers: of course if you send email to a Gmail 

user then Google's going to process it.  But the brouhaha is a timely reminder that 

our expectations of online privacy are probably dramatically different from the 

reality. 
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The Road Not Taken 

Two roads diverged in a yellow wood, 

And sorry I could not travel both 

And be one traveler, long I stood 

And looked down one as far as I could 

To where it bent in the undergrowth; 

Then took the other, as just as fair, 

And having perhaps the better claim, 

Because it was grassy and wanted wear; 

Though as for that the passing there 

Had worn them really about the same, 

And both that morning equally lay 

In leaves no step had trodden black. 

Oh, I kept the first for another day! 

Yet knowing how way leads on to way, 

I doubted if I should ever come back. 

I shall be telling this with a sigh 

Somewhere ages and ages hence: 

Two roads diverged in a wood, and I— 

    I took the one less traveled by, 

    And that has made all the difference. 
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All The World's A Stage 

All the world's a stage, 

And all the men and women merely players; 

They have their exits and their entrances, 

And one man in his time plays many parts, 

His acts being seven ages. At first, the infant, 

Mewling and puking in the nurse's arms. 

Then the whining schoolboy, with his satchel 

And shining morning face, creeping like snail 

Unwillingly to school. And then the lover, 

Sighing like furnace, with a woeful ballad 

Made to his mistress' eyebrow. Then a soldier, 

Full of strange oaths and bearded like the pard, 

Jealous in honor, sudden and quick in quarrel, 

Seeking the bubble reputation 

Even in the cannon's mouth. And then the justice, 

In fair round belly with good capon lined, 

With eyes severe and beard of formal cut, 

Full of wise saws and modern instances; 

And so he plays his part. The sixth age shifts 

Into the lean and slippered pantaloon, 

With spectacles on nose and pouch on side; 

His youthful hose, well saved, a world too wide 

For his shrunk shank, and his big manly voice, 

Turning again toward childish treble, pipes 

And whistles in his sound. Last scene of all, 

That ends this strange eventful history, 

Is second childishness and mere oblivion, 

Sans teeth, sans eyes, sans taste, sans everything. 
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Type the text below in Word 
 
--Use Times New Roman as the font 
--Font size will be 12 
--Double Spaced 
--Italicize all “Antiochus” 
--Bold all instances of “God” 
--Name & save your file as “00—Collier--1 Page—10.14.14”  Substitute your 
student number and name with “00—Collier” 
 

With a grim smile and a grip on his existence’s crutch, he obliviously began 
to breathe a few of his last breaths.   

“Mock all you want, great Antiochus; your days were numbered the 
moment you received that rod.  Such power, greatness, and wealth it brings you, 
yet with it comes your destruction.  Please do recall, Antiochus, that those 
precious scrolls you just burned prophesy of your death.  Shall I read them to you, 
dear Antiochus, or would you rather be surprised?” 
 Ignoring the irritating voice in his head, Antiochus shook off this odd 
occurrence.  It could be reckoned that hearing voices in his head was something 
he was accustomed to.   
 “Will you remain this proud of your evil deeds when you face the great 
Throne of Judgment?  What entertainment I will find in watching you shrivel and 
shrink as you attempt to reiterate the great speech you have prepared for the 
Living God you have so blasphemed!  Shall I speak for you as you may not have 
the courage?  Should you bid me to not say a word so you can attempt to lie 
before the glorious, omniscient God you on earth called lower than you?  Or 
should you try to tell the truth to see if your one show of honesty will cause Him 
to alleviate your sentence a little?  Of course, I have read the prophecies of your 
experience at Judgment Day.  May I tell you of the pride that should consume you 
even before the Throne of God?  Let me tell you of God’s reaction to the evil 
deeds of the great ‘manifestation of Zeus’?”  
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October 6, 2015 

 

Dear Ms. Property: 

 

Angela Property 

220 Corporation Way 

Somewhereville, VA 22590 

I hope that you are doing well. My name is Lydia Lease, and I am an attorney at Sell Your 

House, Inc. I am writing in regards to a parcel of land located at 225 Parcel St., Richmond, VA. 

My client, Mrs. Tabitha Land, is running into some difficulties in selling her property that is 

apparently still under lease by your organization. 

 

This parcel of land (100 ft by 300 ft) is located at the back of my client's property. According to 

the city records, the lease was initiated in September, 2010, and never terminated. After calling 

your lease office, it appears that you no longer make use of this property. In order for my client 

to be able to sell her property, the lease must be cleared. This parcel of land is still under your 

organization's name. I have attached the documents describing the lease and ask that you clear 

your name from this property as soon as possible. 

 

My client is wishing to put her property on the market by January, 2016. In order to do so, this 

parcel of land must be cleared from your organization's hold. I have enclosed the city's 
documents concerning the ownership of this land as well as termination documents for your use. 

If you have any additional questions or concerns, please feel free to contact me at (123) 456-

7890. I look forward to working with you to resolve this matter. 

 

Sincerely, 

Lydia Lease 
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LOLA REIN 
          
 The only ones left to tell first-hand accounts of the Holocaust are those who were children when 

it occurred.  Many children were more fortunate than others, for many were hidden before being taken 

to concentration camps.  However, often times, being in hiding was just as traumatic as being in a 

concentration camp.  Such was the case for Lola Rein. 

 Lola Rein was born in Poland in 1934, putting her around the age of seven when the Holocaust 

began to affect her community.  Promptly after taking control of her region, the German soldiers placed 

the Jews of her community in a ghetto.  It was in the ghetto that her mother sewed Lola what would be 

her only possession for most of the Holocaust: an embroidered dress.  Early in the Holocaust, Lola’s 

father was beaten to death by the Germans; and after barely surviving the first deportation, her mother 

was unlawfully killed by a German soldier while on her way to work.  Lola was left only with her 

grandmother who made plans for Lola’s escape to a hiding place.  Lola obeyed her grandmother’s 

directions and found herself in the care of a Ukrainian woman.  Unfortunately, the woman’s son-in-law 

believed taking Lola in was a bad idea and threatened to denounce the two of them.  The woman was 

forced to send Lola to her sister in a nearby village.  Since her older son had close connections with the 

Germans, conditions at this woman’s house were bound to be worse than ever.  In order to keep 

suspicions as low as possible, the sister had dug a four by six foot hole in her barn to hide Lola, a Jewish 

woman, and the Jewish woman’s two children.  Lola’s presence was unwelcomed by the other Jews 

because she took up some of their limited space and food.  Life in the hole consisted of fighting intense 

hunger, battling head lice, and using a bucket as a bathroom.  In order to alleviate the problems with 

head lice, the Jewish woman had to cut Lola’s hair which caused immense emotional trauma for Lola 

since the Jewish woman’s son mocked her relentlessly.  After seven months of battling hunger, head 

lice, and other terrible conditions, Lola and the Jewish family were released from the hole, for the 

Soviets had liberated their region.  Unfortunately, Lola was an orphan, having the dress her mother 
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made as her only possession.  She spent about a year wandering around battling homelessness until she 

finally met a Jewish family who, having lost their child in the Holocaust, decided to help her.  They were 

able to find a surviving relative: her uncle.  Her uncle readily took her in and raised her as his own.   

In Night by Elie Wiesel, one reads about a young boy’s experience in a concentration camp.  

Lola’s experience in the hole is close in comparison to Elie’s experience in the camp.  Both Elie and Lola 

had to fight starvation.  Also, both had to deal with fellow victims who embraced the idea that they 

should fight for their individual survival rather than help their whole group.  Another similarity is that 

both children were orphaned when they were finally liberated.  However, Elie had more violent 

encounters with the German army.  Also, Lola dealt with different ailments, such as head lice.  Lola 

spent her time in a tiny hole; whereas Elie had a huge camp.  Despite the minor differences between the 

two stories, Elie’s and Lola’s experiences were all about methods of survival and attempting to return to 

normalcy. 
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How to Write a Business Email (Updated for 2018) 

 

Business emails are a pillar of modern communication. On any given day, the average office worker 
receives over 80 emails. 

That’s a lot of communication. 

While we send a lot of emails, many of them are not effective. Everyone’s inbox holds those difficult 
to read or process emails, hanging around because the recipient is unclear on how to reply or act. 
Don’t let that happen to your business emails. Etiquette, style, and format are essential to writing 
emails that get results. 

This article will highlight best practices and walk you through an effective business email, step-by-
step. By integrating these methods into your email preparation, you will write better emails and 
improve overall communication. 
 

Four Key Questions: 

There are four questions that you must consider as you begin to draft a business email: 

  

1. Who is My Audience? 
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In all business writing, the audience is the top consideration. Who you are writing for will 
determine how you write your email. The reader will determine the tone, formality, and content of the 
communication. 

Your email’s reader may be your colleague, client, or supervisor. Each reader will have a different 
background, project knowledge, and priorities. You can use project acronyms with a colleague who 
has the same deep project knowledge as you do. Those same acronyms will be confusing to an 
executive who needs an update for budget forecasting. 

With your audience at the forefront, you will always write a more effective email. 

The audience includes all the people included in the sender fields. This includes the To:, CC:. and 
BCC: fields but main focus should be on those in the To field. Writing for the audience also means 
using these fields correctly. 

  

 

 The ‘To:’ field is for the direct audience who needs to reply or take action from the email content. 
The ‘CC:’ field is for readers who need to receive the email conversation for reference or clarity, but 
do not need to take action nor reply. The ‘BCC:’ field is for the audience who only needs to see the 
initial email and none of the later chain of replies. 

Incorrect usage of the sender fields is a common business email mistake. It occurs when the 
audience and their roles are not thoughtfully considered. 

Use the Bcc field very judiciously. Often it's best to forward an email separately, with a brief 
statement on why you're sending this information. 

  

2. What is the Purpose? 

An email must have a purpose. And it must have only one purpose. 

This email practice is called the ‘one thing rule’. 
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Each email should cover only one specific item, task, or request. Covering multiple actions in one 
email can cause confusion and inefficiency. One email should not include both client report revision 
notes and a scheduling question for the quarterly meeting. This scenario calls for two separate 
emails. 

By limiting emails to one thing, the email is easier for the recipient to understand, process and act 
upon. This clarity increases understanding and productivity. 

In practice, we sometimes have to ask for several pieces of information related to the same topic. In 
this case, use a numbered list to clarify for your reader that the request has components. This will 
help your reader respond easily and ensure you receive all the specifics you need. 

I need you to review these three items before we release the sketch to the production team: 

1. Content 
2. Design 
3. Color choice 

  

3. Is This Email Necessary? 

There is a tendency to over-communicate by email. While email is efficient and provides an 
electronic paper-trail, not all communication should occur over email. 

Ask yourself: “Is this email really necessary?” Perhaps a quick phone call or a ping on the company 
messenger is more appropriate. If you’re expecting a lot of back-and-forth on the topic, a short 
conversation can eliminate a lengthy email chain. 

Choose the right channel to send information. Email is great, but it's one channel. 

4. Is Email Appropriate? 

Email can be used in many scenarios but is not always appropriate. 

If you are delivering bad news, do so in person or buffer the email thoughtfully. An email is 
impersonal and is difficult to convey empathy or compassion. If you must write a business apology 
email follow these rules. 
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Sensitive information sent by email runs the risk of being accidentally shared. There are plenty of 
cases of email mishaps, ranging from funny to serious. Whether the information is personal contact 
or personal opinion, consider whether it’s appropriate for an email. If you wouldn’t want it 
accidentally shared, be very thoughtful about how it is sent in the first place. 

If you are unsure if an email is appropriate, ask yourself if you'd be comfortable with that email being 
projected in a meeting. Attending the meeting are your boss, all your future bosses, and your 
mother. If it passes this test, then send it. If not, there is likely something that is not appropriate. 

  

Email Style 

Business emails have a very specific style. They are professional but brief. They should be written to 
be skimmed, but with enough information to allow a complete response. 

If you like this article you may be interested in our online email writing course. 

 
Tone 

Finding the correct tone can be the biggest headache in drafting an email. The tone changes based 
on your audience. It can range to formal to friendly but is always professional and should always be 
matched to your audience. 

Wordy politeness can often be overlooked in efforts to be brief in emails. However, please and thank 
you should be included anytime it is appropriate. 

 

Avoid ALL CAPS because it SOUNDS LIKE YOU’RE YELLING (and could route your email to the 
spam folder). If you wouldn’t shout the statement in person, don’t shout it in an email. Instead, 
use italics, underlining or bold to emphasize important points. 

Example: Vacation requests must be submitted at least two weeks in advance. 

Notice the harsh tone if the bold text is swapped for caps: Vacation requests must be submitted AT 
LEAST TWO WEEKS IN ADVANCE.  

One exception: Do use all caps in email headings when writing to any organization that strips 
html formatting from email. The military, military academies, and some financial institutions with 
strict security protocols often strip html formatting.  

Headings are very helpful to readers. They allow a reader to skim and find information easily. 
They're a business writer's best weapon against information overload. 

Avoid excessive use of punctuation or emojis. Exclamation points should be used sparingly! Emojis 
continue to have a larger role in digital communication and several style guides have approved 
their judicious use in business writing. I follow the rule of only using them after the other party has 
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sent one. They should never be used in formal business emails. 
 

Format 

Emails are meant to be skimmed, so they should have plenty of white-space to assist the reader. 
Use shorter paragraphs, lists and bullet points to streamline the information. And, use headings to 
break up concepts and allow a reader to skim. 

In addition, awkward formatting copied from other documents or emails can be distracting. To have 
seamless formatting for your email, strip the text formatting of the new content by using your email 
client’s Remove or Formatting function. 

Here are the most common formatting features and how to use them. 

 

Font: The font is the typeface that you should choose for your email. It is best to choose a sans serif 
(a typeface without decorative strokes at the end) as they are more modern and simple and easy to 
read onscreen. They are also easier to read at a small size. Gmail uses Sans Serif as the default. 
You could also use Arial, Helvetica, Tahoma, Terbuchet MS, or Verdana. 

 

Text Size: You should try to keep your email in the normal size. This is between 10–12pt. 

 

Bold: You can use bold for headings and to emphasise important text. Bold text catches the eye of 
readers as they scan the email. 

 

Italics: Italics are a softer way to draw attention to an area of text. They are used to bring emphasis 
to an area of a sentence. They do not make words stand out when the user is scanning a page the 
way bold text does. Italics should also be used for titles of full works. 
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Underline: Underlined text can easily be confused for a link. When writing an email, it's best not to 
use underlined text to draw attention to an area of an email. It is better to use bold or italics. 

 

Text Color: You should avoid using multiple text colors in an email as it draws the eye in to multiple 
locations and looks unprofessional. It is likely that your email program makes your hyperlinks blue.  

 

Alignment: Business writing uses text that is fully aligned left. Academic writing indents the first 
sentence of a paragraph five spaces. In business email, you will never need to indent the start of a 
paragraph.  

Users scan pages in a F-shapped pattern. By changing the alignment it makes it more difficult for the 
reader to skim. 
 

 

Numbers: Using a numbered list can help organize content where the sequence is important. For 
example if you were describing steps you would want to use a numbered list. 

 

Bullet Points: Bullet points are a great way to create white space on your page and draw attention 
to related items. Bullet points work best for unordered lists.  
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Indent More: In business emails you should not indent the first sentence of a new paragraph. A line 
break represents the start of a new paragraph. The indent more button allows you to add an indent 
to text. This is useful on rare occasions when you want to indicate that some information is a subset 
of what preceeded it. It creates a visual indication that the indented information is less important. 

 

Indent Less: This allows you to move your content to the left 

 

Quote Text: If you are referring to quoted text you should use the quote text function. It provides a 
slight indent to your content and a grey vertical line to the left. This shows readers that you are 
quoting text. 

 

Remove Formatting: If you are pasting text into your email it is vital you use the remove formatting 
function. Otherwise you will paste the text styles and it will be obvious to your reader that you copy 
and pasted that text. To use this function select the text you want to remove formatting. Then click 
the remove formatting button. 
 
 

Email Overview 

Let's dissect each section of a business email to highlight best practices for you to implement in your 
writing. 
 

Subject Line 

The subject line is the mini-summary of your email. It provides the biggest opportunity to ensure your 
email gets read. The goal of a subject line is to get your reader to open the email without tricking 
them. It is also the place where mistakes are most commonly made. 

Think of it as your email’s headline. It should be a 3- to 8-word overview of the content. 

Subject lines that are too brief or too lengthy cause confusion. If it makes the email seem difficult or 
confusing to reply to, the recipient may not open it immediately or at all. 
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Bad Examples: 

‘Important!’ 

‘For Your Review’ 

‘Questions About Expansion Performance Target Report Deadline Extension Request” For Client 
Meeting’ 

Good Examples: 

‘Your BookShop Order Delivery Dec 2’ 

‘Client Report Revisions: Please Review by 4 PM’ 

‘Expansion Report Extension Requested until Friday’ 

Email clients will also review the subject line for signs of spam. This is especially important for sales 
teams who may be cold-emailing clients. Certain terms are flags for spam algorithms and may be 
filtered to a Junk folder. Avoid using words such as ‘Sales’, ‘Please read’ or ‘Profits’, or having one-
word subjects. 

 
Greeting 

Your greeting should be professional and concise. It is always preferable to address the recipient 
using their name, but it may not always be possible. 

Good afternoon, 

Greetings, 

Dear Ms. Jones: 

Hi Jeff, (salutation format) 

Hi, Jeff. (sentence format) 

 
Brief Pleasantry 

If you’re emailing someone for the first time, your opening line could be a short pleasantry 
connecting you and the recipient. One sentence should be enough. Indicate how you connected. 
This reminder will give the reader context for the following information. 

“It was great to meet you at last night’s networking event.” 

If you’ve received something from the recipient, offer your thanks. It could be a thank you for an offer 
of assistance, for an interesting piece of content they shared or even for simply reading the email. 
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“Thank you for sharing your article on management strategies. The findings are valuable.’ 

‘I appreciate you taking the time to help me with this project.’ 

If you want to keep it general, warm well-wishes will do. 

‘I hope you’re well!’ 

Omit a pleasant greeting if you’ve recently or frequently communicated with each other. 

Be very careful of overspinning pleasantries at the start of the email. The purpose of your email 
should be the overt start. Remember the acronmy B.L.O.T — bottom line on top. What do you want 
your reader to know or do? That's the most important opening. 

  

Purpose 

As previously noted, each email should address just one thing, one purpose. This task, request or 
information should be presented clearly and directly after the pleasantry. This is the 
B.L.O.T— bottom line on top. 

Be concise and direct. Don’t hide your request or it can easily be overlooked or ignored. 

‘Please provide your feedback on the budget.’ 

‘Can you participate in the project kick-off meeting next Thursday? 

‘Did you have any revisions to the final report?’ 

Remember the acronym B.L.O.T. — Bottom Line On Top 
 

Additional Information 

Some business emails may require additional information for the reader. It could be clarification on 
the task, a link to resources or examples, or other helpful information. This information should be 
included thoughtfully. Only directly relevant content should be added. 
 

Call to Action  

Near the end of the email, include a specific call to action. The email is being sent to accomplish one 
task. The call to action should leave no confusion as to your request. Do not assume the reader 
understands the desired result from prior information. Emails can easily be misinterpreted if there is 
any grey area. 

This statement should include the specific action and the timeline. If you are sending the email to 
multiple people, clarify task responsibility by directly naming the intended person. 
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Clarification of tasks and expectations allows for the recipient to respond more effectively. 

Bad examples: “Can you take care of this?” 

“Let me know what you think.” 

Good examples: “Sarah: can you forward the survey to all staff by Friday at noon, please?” 

“I’d appreciate your feedback on the draft agenda. If you have any edits, please send them by 
tomorrow, Tuesday, at 10 AM.” 

If you would like a confirmation, you can phrase the call to action as a question. If the call to action is 
a notification that does not necessarily require a reply, you can structure the call to action as a 
statement. 

 
 
Closing Message  

The closing message simply indicates that the email is complete. While it is not a requirement in 
modern email writing, a brief, polite phrase will nicely round out your email. 

‘Thank you for your time,’ 

‘I look forward to your response,’ 

‘Kind regards,’ 

  

Sign-off & Signature 

The end of the email includes a sign-off of your name. The phrasing should match the formality of 
the email. 

Most formal: Dr. John Smith 

Dr. Smith 

John Smith 

Least formal and most common: John 

Your email signature is a type of electronic business card that is appended to your email. It should 
include the most important context and contact details for your reader. This is the place to help your 
reader with relevant contact or contextual information, not brag or insert philosophical quotes. 
Images and logos can be useful, but be aware of the sizing and how they will appear on mobile 
devices. 
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Attachments and Links 

Any referenced attachments or links must be included in the email. Either name the file so that it is 
clearly identified or include the document title in parenthesis immediately after you mention it in the 
email. 

Don’t make the reader go hunting for the information they need. 

If an attachment was sent to the recipient previously, attach it again anyway. This way, they can 
easily access the information rather than searching through their inbox. Of course, double-check that 
the file is attached and correct. Forgetting to include an attachment requires an unnecessary (and 
embarrassing!) reply requesting it, which can delay the work. 

Links can be directing the reader either to websites or to intranet directories. These hyperlinks can 
be lengthy and distracting in email text. Instead, integrate the hyperlink into the existing sentence. 

Bad example: You may find this resource useful in preparing the 
report: http://www.instructionalsolutions.com/blog/technical-writing-engineers 

Good example: You may find this technical writing resource useful in preparing the report. 

You should also test the link to ensure that it opens the correct site. 

  

Review 

Once your email is composed, do not click send. Yet. 

Take a moment to review your email. Check for grammatical or spelling errors (Grammarly has a 
helpful free tool). Typos suggest carelessness and can even convey incorrect information. 

 

Double-check dates, times, names, links, attachments and other specific details.  

Triple-check that the correct recipients are in the sender fields. 
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Organization & File Management Project 

 

This quarter you’ll create more than 40 files for the projects you’ll accomplish for Mr. Collier and Mrs. 

Snow.  Additionally, you’ll turn in each file electronically to Mr. Collier.  Therefore, you’ll need to keep 

your files organized and easy to find.  To keep your files organized you’ll need to follow three main 

procedures to keep files organized. 

1)  Name the file so it is easy to tell what the file is and when you created the work.  For this class 

you’ll name the files using your student number, your last name (or first name), the name of the 

project and finally the date that you last worked on it. Example:  03—Henry—Letter—10.09.17 

2) Create folders to keep related items together.  In our class we’ll organize our folders by the 

week an item is due. 

3) Keep backup copies both on the computer hard drive and on your USB drive.  Additionally, if you 

worked on a project yesterday and will work more on it today, rename the file you worked on 

yesterday by Renaming with the current date.  For example, we used 03—Henry—Letter—

10.09.17 yesterday, we’d rename it 03—Henry—Letter—10.10.17.  Once you finish a project, 

copy it to the USB Drive. 

Create the following folders in your Document folder AND your USB Drive 

 

1)  Right click on Start 

2) Select Explore 

3) Click on the Documents folder 

4) At the top of the Ribbon, select the File tab and then New, then Folder 

5) Name the folder as listed above (Start with “Research Report”) 

6) Continue step 4 through 5 until you’ve created the required files. 
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Churchill Still Stands Alone 
By BORIS JOHNSON 

 

When I was growing up, there was no doubt about 

it: Winston Churchill was the greatest statesman 

Britain had ever produced. 

My brother and I pored over Sir Martin Gilbert ’s 

biographical “Life in Pictures” enough to memorize 

the captions. I knew that Churchill had led my 

country to victory against one of history’s most 

disgusting tyrannies. I knew that he had a mastery 

of the art of speechmaking, and I knew, even then, 

that this art was dying out. I knew that he was 

funny, irreverent and (even by the standards of his 

time) politically incorrect. 

At suppertime, we were told the apocryphal stories: 

the one where Churchill is on the lavatory, is 

informed that the Lord Privy Seal wants to see him 

and says that he is sealed in the privy. We knew the 

one where Labour member of Parliament Elizabeth 

Braddock allegedly tells him that he’s drunk, and he 

shoots back, with astonishing rudeness, that she’s 

ugly, while in the morning, he’d be sober. 

I knew that he had been amazingly brave as a young 

man, that he had killed men with his own hand and 

that he had been fired at on four continents. I knew 

that he had been a bit of a runt at Harrow, his 

famous boarding school near London; that he was 

only about 5 feet 7 inches with a 31-inch chest; and 

that he had overcome his stammer and his 

depression and his appalling father to become the 

greatest living Englishman. 

I gathered that there was something holy and 

magical about him because my grandparents kept 

the front page of the Daily Express from the day he 

died in 1965, at the age of 90. I was pleased to have 

been born a year before his death: The more I read 

about him, the more proud I was to have been alive 

when he was too. 

Most Americans, when they think of Churchill at 

all, seem to retain that pride and reverence. So it 

seems all the more sad and strange that today—

nearly 50 years after his death—he seems in some 

danger of being shoved aside in the memory of the 

nation he saved. British students who pay attention 

in class are under the impression that he was the 

guy who fought Hitler to rescue the Jews. But a 

June 2012 survey of about 1,000 British secondary 

school students aged 11 to 18 showed that while 

92% of them could identify a picture of a dog 

named Churchill from a popular British insurance 

advertisement, “only 62% correctly identified a 

photo of Sir Winston Churchill.” 

That fading memory is a particular shame, since 

Churchill is so obviously a character who should 

appeal to young people today. He was eccentric, 

over-the-top, even camp, with his own trademark 

clothes and genius. 

Of course, a hundred books a year are published on 

him—and yet we cannot take his reputation for 

granted. The soldiers of World War II are gradually 

fading away. We are losing those who can 

remember the sound of his voice. But we should 

never forget the scale of his deeds. 

These days, we dimly believe that World War II 

was won with Soviet blood and U.S. money; and 

though that it is in some ways true, it is also true 

that, without Churchill, Hitler would almost 

certainly have won, and Nazi gains in Europe might 

well have been irreversible. 
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John Doe 

Full Address ▪ City, State, ZIP ▪ Phone Number ▪ E-mail 

 

 

OBJECTIVE: Design apparel print for an innovative retail company 

 

EDUCATION: 

 

UNIVERSITY OF MINNESOTA                                                                                                   City, State 

College of Design                                           May 2011 

 Bachelor of Science in Graphic Design  

 Cumulative GPA 3.93, Dean’s List 

 Twin cities Iron Range Scholarship 

 

WORK EXPERIENCE: 

 

 AMERICAN EAGLE                                                                                                                       City, State 

 Sales Associate                                                                                                                    July 2009 - present 

 Collaborated with the store merchandiser creating displays to attract clientele 

 Use my trend awareness to assist customers in their shopping experience 

 Thoroughly scan every piece of merchandise for inventory control 

 Process shipment to increase my product knowledge 

 

 PLANET BEACH                                                                                                                             City, State 

 Spa Consultant                                                                                                                   Aug. 2008 - present 

 Sell retail and memberships to meet company sales goals 

 Build organizational skills by single handedly running all operating procedures 

 Communicate with clients to fulfill their wants and needs 

 Attend promotional events to market our services 

 Handle cash and deposits during opening and closing  

 Received employee of the month award twice 

 

HEARTBREAKER                                                                          City, State 

 Sales Associate            May 2008 – Aug. 2008 

 Stocked sales floor with fast fashion inventory 

 Marked down items allowing me to see unsuccessful merchandise in a retail market 

 Offered advice and assistance to each guest 

 

VICTORIA’S SECRET                                                                                                                    City, State 

Fashion Representative                                                                                                  Jan. 2006 – Feb. 2009 

 Applied my leadership skills by assisting in the training of coworkers 

 Set up mannequins and displays in order to entice future customers 

 Provided superior customer service by helping with consumer decisions 

 Took seasonal inventory 

 

VOLUNTEER EXPERIENCE: 

 

 TARGET CORPORATION                                                                                                             City, State 

 Brand Ambassador                                                                                                                        August 2009 

 Represented Periscope Marketing and Target Inc. at a college event 

 Engaged University of Minnesota freshman in the Target brand experience 
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Project Instructions 

 

Tab Project 

o Font:  Arial 

o Set Page Orientation to Landscape 

o Set Margins to 1 inch 

o Bold title (Products), center justify and use font size 24 

o Set Left Tabs at 3 inches and 5.25 inches 

o Set a Decimal Tab at 8 inches 

o Underline column headings set font size to 20 inches 

o Use font size of 16 for individual items in the columns 

 

Table Project 

o Font:  Calibri Body, font size 18 

o Set 1 inch margins 

o Insert a table with 3 columns and 18 rows 

o Set the width of the 1st column to 3.25 inches 

o Set the width of the 2nd column to 1.5 inches 

o Set the width of the 3rd column to 1.25 inches 

o Add borders to the outside and inside of the table 

o Shade the appropriate cells 
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Category  Percentage  

Gross Income (per month)   

1. Tithe 10%  

2.  Taxes 27.65%  

NET Spendable   

3.  Housing 35%  

4.  Food 7%  
5.  Transportation 15%  
6.  Insurance 8%  
7.  Debts 5%  

8.  Entertainment/Recreation 5%  
9.  Clothing 3%  

10.   Savings 5%  

11.   Medical/Dental 8%  
12.  Miscellaneous 5%  
13.  School/College Classes 4%  
14.  Investments   

15.  Charitable Giving   
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MACBETH 

 

Among the many interesting themes Shakespeare explores in his Macbeth, his 

exploration of the cause and effect of supernatural intervention is quite fascinating. The role of 

the supernatural in this play is quite important, for the supernatural works as a catalyst for 

Macbeth’s tragic fall. Through the symbol of sleep, the symbol of hallucinations, nightmares, 

and other forms of restlessness, and Macbeth’s and Lady Macbeth’s insanity, the supernatural 

and natural play a great part in the plot of Macbeth.  

In Macbeth, sleep symbolizes a necessity in life and is portrayed as something natural. 

Macbeth says about sleep, “Balm of hurt minds, great nature’s second course, /Chief nourisher in 

life’s feast” (Macbeth 2:2). Sleep is necessary for humans to function and to stay psychologically 

together. When Macbeth murders sleep” (Macbeth 2:2).  If Macbeth does not sleep, he is quite 

vulnerable to hallucinations and psychological problems.  

In this play, hallucinations nightmares, and any forms of unrest are symbols of the 

supernatural.  

Macbeth does not destroy anything natural in his life when he kills Duncan; for he 

officially embraces a supernatural, undead state of living when he makes the decision to kill 

Duncan. Once he makes this decision, Macbeth has his first hallucination. During this time, he 

says, “Nature seems dead, and wick instead of sleep”, he and his wife will have nightmares or 

sleep-walk and sleep-talk, but they will not rest. Without rest, they are made vulnerable to 

insanity; and the more of the supernatural they encounter, the more insane they grow.

32



Because Macbeth has killed the necessary for living naturally, he and his wife have no 

choice but to live unnaturally as ghosts do. For example, they continually encounter supernatural 

things such as Lady Macbeth’s sleep-talking and hallucinations and Macbeth’s encounters with 

Banquo’s ghost. Also, he and his wife cannot die by natural causes because that is a form of 

sleep according to Lady Macbeth: “The sleeping and the dead/ Are but as pictures” (Macbeth 

2.2). They instead will be forced to live in a restless state with their minds slowly deteriorating 

until they die in some terrible way.  

Sleep, sleeplessness, and insanity are all connected in Macbeth by supernatural and 

natural elements. Shakespeare’s use of the supernatural is quite effective in this work; for, 

through the supernatural, the story of Macbeth really comes alive while the poor character of 

Macbeth must embrace a death of natural things. “Had I but died an hour before thus chance,/ I 

had lived a blessed time; for from this instant / There’s nothing serious in mortality” (Macbeth, 

2:3).  
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THE FARM IN TENNESSEE 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

IMA STUDENT 
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MR. COLLIER  
COMPUTER  
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THE FARM IN TENNESSEE 

 

Thesis:   The Farm is a bad example of a Utopian community. 

I. Introduction 
A. Imaginary place with perfect political and social system 
B. Location and duration 

1. Summertown, Tennessee, USA 
2. 1971 to present day 

 
II. Stephen Gaskin 

A. Life 
1. Married twice 
2. College 

B. Founder 
III. Principles 

 
A. Nondenominational 

1. Earth sacred 
2. Child care holy 
3. Humanity change to survive 
4. Inner peace equals world peace 

 
B. Rules 

1. Compassionate 
2. No violence 
3. Resolve conflicts peaceably 

iii 
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4. No weapons 
5. No animals for slaughter 
6. Accept responsibilities 

 
IV. Community 

A. Individuals with different ideas about spirituality 
B. Life/Entertainment 

1. Youth center 
2. Nature walks 

C. Responsibilities 
1. Mom 

a. Raises children 
b. Takes care of home 

2. Dad 
a. Provides for family 
b. Helps with children 

D. Success 
1. Safe haven for religious wanderers 
2. Healthy nature 

 

V. Conclusion 
A. Nondenominational 
B. Learn to care about others 
C. Replies on inner strength 
D. Opinion 

1. Waste of time 
2. Nothing without God 

 

 

iv 
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THE FARM IN TENNESSEE 

 

  The Farm is a Utopian community. A Utopian community is a place with a perfect political and 

social system. The Farm is an example of such a community. The Farm is located in 

Summertown, Tennessee, and has been around since its establishment in 1971. The Farm is a 

bad example of a Utopian community. 

     Stephen Gaskin was the founder of this community. He established this after he was married 

twice, out of college, and became a hippy dissatisfied with the government. The humorous 

thing about him is that although he founded the Farm, he never considered himself the leader 

of the community. 

     The Farm claims to be “nondenominational,” but, in truth, everyone in the community is a 

hippy. They believe the earth is sacred and consider child care to be holy. It is their belief that 

humanity must make changes to survive, and inner peace equals world peace. The rules are 

also ridiculous; they address no real problems in the society. According to the law, everyone  

must be compassionate and polite. There will be no violence within the community, and they  

 

1 
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2 

will resolve conflicts calmly and peacefully. By law, there can be no weapons of any kind within  

their domain. Also, no animals of any kind will be kept with the intention to kill and eat them. 

Above all, one will assume responsibility for any action one commits. 

     They admit that everyone in the Farm is an individual with different ideas about spiritual 

beliefs. For fun, the Farm has a Youth Center and takes those interested on nature walks 

through the surrounding forests. The parents of children also have responsibilities regarding 

family livelihood. The mother is to stay home, raise the children, and keep the house in order. 

The father is to provide for the family’s needs and is required to help with the children. This 

community is somewhat a success. The Farm undoubtedly has a very healthy ecosystem 

nearby. 

     In conclusion, the Farm is rather unique in its own way. It is a nondenominational community 

where people can learn to care for one another. Unfortunately, this community has a rather 

large problem. The Farm relies solely on human strength. In my opinion, this makes the Farm a 

waste of valuable time and money. Although the Farm has been “up and running” for over  

thirty years, it will eventually fail, for Stephen Gaskin missed a very important thing when he 

founded the Farm in 1971: God 
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8. Center the page number (an arabic numeral) on the seventh line (1 inch) above
the bottom edge of the page. The numbering continues from the preceding pages

of the paper.

9. For any succeeding pages, center the page number on the seventh line (1 inch)
fiom the top edge of the page. Leave one blank line between the page number
and the first line of the text.

l inch

WORKS CITE
l->/
It

1 inch 1 inch

:

Typing Your Papen

204 44



$tgp $ Pt*putu a list sf the wsrks cited in your paper.

a. Your bibliography cards should be alphabettzed, by the author's last name or the first
word of the title if no author is given.

b. Set aside any sources that you did not cite in your paper.

c. From the cards that remain, prepare an alphabetized list of works cited. Refer to the
example given below and to the Appendix.

Note: The WORKS CITED page lists only those sources actually cited in a paper. If you wish to
include some sources that you consulted but did not cite in your paper, you could list these
additional sources on a separate page under the heading FOR FURTHER RIADING.

EXgfCiSg J Prepare the list of works cited for your research paper according to the instructions4G:$!ffi.^- 
given under Step 8. Remember that you need at least two citations (including one
quotation), although you may have more. List of Works Cited Due: les. 117

15 r Research Paper

''T -

\il -

Unit

WORKS CITED

" Elizab eth G askell " http, / / w * w . sp a rtac us . s cho o lnet. c o . uW J g askell. htm
(accessed April 26, 2011) .

Gaskell, Elizabeth. Maru Barton. London, J. M. Deznt €, Sons,'1932.

Hughes, Linda K,., and Michael Lund. VictorianPublishing and Mrs.
Gaskell's Work Charlottesvllle: Universiil.l P ress of Virginia, 1999.

Matus, JilI L. The Cambridge ComPanion to Elizabeth Gaskell.

Camb ridge : Cambridge Univ ersitt1 P ress, 20 07 .

Merriman, C. D. "Elizabeth Gaskell." 2007. http'//www
. online-literature. coml elizabeth-gaslsll (accessed Ap ril ZS, 2011) .

Sanders, Valerie. 'TheWorks of Elizabeth Gaskeil." Modern Lanc,uaqe

kview'103, no. 3 (Juh.t 2008):835-838.

W right, Edgar. " Elizabeth Gaskell." http t / / w w w. lang. nagoqa- u. ac.jp / -
matsuokalEG-D LB. html (accessed Ap ri| 20, 201 1) .
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Formatting a Research Paper 
If your instructor has specific requirements for the format of your research paper, check them 

before preparing your final draft. When you submit your paper, be sure to keep a secure copy. 

The most common formatting is presented in the sections below: 

• Margins 

• Text Formatting 

• Heading and Title 

• Running Head with Page Numbers 

• Placement of the List of Works Cited 

• Tables and Illustrations 

• Paper and Printing 

• Corrections and Insertions on Printouts 

• Binding a Printed Paper 

• Electronic Submission 

Margins 

Except for the running head (see below), leave margins of one inch at the top and bottom and on 

both sides of the text. If you plan to submit a printout on paper larger than 8½ by 11 inches, do 

not print the text in an area greater than 6½ by 9 inches. 

Text Formatting 

Always choose an easily readable typeface (e.g., Times New Roman) in which the regular type 

style contrasts clearly with the italic, and set it to a standard size (e.g., 12 points). Do not justify 

the lines of text at the right margin; turn off any automatic hyphenation feature in your writing 

program. Double-space the entire research paper, including quotations, notes, and the list of 

works cited. Indent the first line of a paragraph half an inch from the left margin. Indent set-off 

quotations half an inch as well (for examples, see 76–80 in the MLA Handbook). Leave one 

space after a period or other concluding punctuation mark, unless your instructor prefers two 

spaces. 

Heading and Title 

Beginning one inch from the top of the first page and flush with the left margin, type your name, 

your instructor’s name, the course number, and the date on separate lines, double-spacing the 

lines. On a new, double-spaced line, center the title (fig. 1). Do not italicize or underline your 

title, put it in quotation marks or boldface, or type it in all capital letters. Follow the rules for 

capitalization in the MLA Handbook (67–68), and italicize only the words that you would 

italicize in the text. 

Local Television Coverage of International News Events 
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The Attitude toward Violence in A Clockwork Orange 

The Use of the Words Fair and Foul in Shakespeare’s Macbeth 

Romanticism in England and the Scapigliatura in Italy 

Do not use a period after your title or after any heading in the paper (e.g., Works Cited). Begin 

your text on a new, double-spaced line after the title, indenting the first line of the paragraph half 

an inch from the left margin. 

Fig. 1. The 

top of the first page of a research paper. 

A research paper does not need a title page. If your teacher requires a title page in lieu of or in 

addition to the header, format it according to the instructions you are given. 

Running Head with Page Numbers 

Number all pages consecutively throughout the research paper in the upper right-hand corner, 

half an inch from the top and flush with the right margin. Type your last name, followed by a 

space, before the page number (fig. 2). Do not use the abbreviation p. before the page number or 

add a period, a hyphen, or any other mark or symbol. Your writing program will probably allow 

you to create a running head of this kind that appears automatically on every page. Some 

teachers prefer that no running head appear on the first page. Follow your teacher’s preference. 

Fig. 2. The 

running head of a research paper. 
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Placement of the List of Works Cited 

The list of works cited appears at the end of the paper, after any endnotes. Begin the list on a new 

page. The list contains the same running head as the main text. The page numbering in the 

running head continues uninterrupted throughout. For example, if the text of your research paper 

(including any endnotes) ends on page 10, the works-cited list begins on page 11. Center the 

title, Works Cited, an inch from the top of the page (fig. 3). (If the list contains only one entry, 

make the heading Work Cited.) Double-space between the title and the first entry. Begin each 

entry flush with the left margin; if an entry runs more than one line, indent the subsequent line or 

lines half an inch from the left margin. This format is sometimes called hanging indention, and 

you can set your writing program to create it automatically for a group of paragraphs. Hanging 

indention makes alphabetical lists easier to use. Double-space the entire list. Continue it on as 

many pages as necessary. 

Fig. 3. The 

top of the first page of a works-cited list. 

Tables and Illustrations 

Place tables and illustrations as close as possible to the parts of the text to which they relate. A 

table is usually labeled Table, given an arabic numeral, and titled. Type both label and title flush 

left on separate lines above the table, and capitalize them as titles (do not use all capital letters). 

Give the source of the table and any notes immediately below the table in a caption. To avoid 

confusion between notes to the text and notes to the table, designate notes to the table with 

lowercase letters rather than with numerals. Double-space throughout; use dividing lines as 

needed (fig. 4). 
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Fig. 4. A 

table in a research paper. 

Any other type of illustrative visual material—for example, a photograph, map, line drawing, 

graph, or chart—should be labeled Figure (usually abbreviated Fig.), assigned an arabic 

numeral, and given a caption: “Fig. 1. Mary Cassatt, Mother and Child, Wichita Art Museum.” 

A label and caption ordinarily appear directly below the illustration and have the same one-inch 

margins as the text of the paper (fig. 5). If the caption of a table or illustration provides complete 
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information about the source and the source is not cited in the text, no entry for the source in the 

works-cited list is necessary. 

Fig. 5. A 

figure in a research paper. 

Musical illustrations are labeled Example (usually abbreviated Ex.), assigned an arabic numeral, 

and given a caption: “Ex. 1. Pyotr Ilich Tchaikovsky, Symphony no. 6 in B, opus 74 

(Pathétique), finale.” A label and caption ordinarily appear directly below the example and have 

the same one-inch margins as the text of the paper (fig. 6). 
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Fig. 6. A 

musical example in a research paper. 

Paper and Printing 

If you print your paper, use only white, 8½-by-11-inch paper of good quality. If you lack 8½-by-

11-inch paper, choose the closest size available. Use a high-quality printer. Some instructors 

prefer papers printed on a single side because they’re easier to read, but others allow printing on 

both sides as a means of conserving paper; follow your instructor’s preference. 

Corrections and Insertions on Printouts 

Proofread and correct your research paper carefully before submitting it. If you are checking a 

printout and find a mistake, reopen the document, make the appropriate revisions, and reprint the 

corrected page or pages. Be sure to save the changed file. Spelling checkers and usage checkers 

are helpful when used with caution. They do not find all errors and sometimes label correct 

material as erroneous. If your instructor permits corrections on the printout, write them neatly 

and legibly in ink directly above the lines involved, using carets (⁁) to indicate where they go. Do 

not use the margins or write a change below the line it affects. If corrections on any page are 

numerous or substantial, revise your document and reprint the page. 

Binding a Printed Paper 

Pages of a printed research paper may get misplaced or lost if they are left unattached or merely 

folded down at a corner. Although a plastic folder or some other kind of binder may seem an 

attractive finishing touch, most instructors find such devices a nuisance in reading and 

commenting on students’ work. Many prefer that a paper be secured with a simple paper or 

binder clip, which can be easily removed and restored. Others prefer the use of staples. 
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Electronic Submission 

There are at present no commonly accepted standards for the electronic submission of research 

papers. If you are asked to submit your paper electronically, obtain from your teacher guidelines 

for formatting, mode of submission (e.g., by e-mail, on a Web site), and so forth and follow them 

closely. 

Designed to be printed out and used in the classroom. From the MLA Handbook, 8th ed., published by the 

Modern Language Association. 
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Category  Percentage  

Gross Income (per month)   

1. Tithe 10%  

2.  Taxes 27.65%  

NET Spendable   

3.  Housing 35%  

4.  Food 7%  
5.  Transportation 15%  
6.  Insurance 8%  
7.  Debts 5%  

8.  Entertainment/Recreation 5%  
9.  Clothing 3%  

10.   Savings 5%  

11.   Medical/Dental 8%  
12.  Miscellaneous 5%  
13.  School/College Classes 4%  
14.  Investments   

15.  Charitable Giving   
 

1) Format the 3rd column to Currency, dollars & 2 decimal places 

2) Use $4,525 as the Gross Income (per month) 

3) Use the formula =c2*b3 to compute tithe & then taxes (=c2*b4) 

a. See formula section beginning at page 184 

4) Find NET Spendable (=c2-c3-c4) 

5) Find the amount for the remaining budget categories (multiply 
the Net Spendable Cell by percentage cell). 

6) Add a Total row after item 15.  Then find the sum of items #3 
through 15 
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Quizzes Tests 

1. Type/Enter the following data into an Excel Worksheet 
2. Find the Quiz Average for Each Student 
3. Find the Test Average for Each Student 
4. Find the Class Average for Each Quiz & Each Test 
5. Find the Students’ Overall Grade  

Quizzes Count 40% of overall grade 
Test count 60% of overall grade 
Hint:  Overall Grade = (Quiz Average)*.4 + (Test Average)*.6 

 
NOTE:  Use textbook beginning on page 184 
The Average function will be useful to you.  Example:  =Average(B2:B10) 

1 2 3 1 2 3 
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I.  Bar Graphs 

Departmental Sales Figures 

     

First Quarter     

 April May June Totals 

Sam $23,100.00 $38,500.00 $40,050.00 $101,650.00 

Greg $18,500.00 $24,750.00 $47,000.00 $90,250.00 

Susan $15,500.00 $35,200.00 $34,250.00 $191,900.00 

     

  Group Total $383,800.00 
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Pie Chart Problems 

1)  Mrs. Greene’s class made 6 A’s, 16 B’s, 8 C’s and 2 D’s on their research paper 

Create a pie chart to show the grades for her class. 

Title the pie chart “Research Paper Guides” 

2) 500Americans were surveyed and asked the question: “Why do you eat at a fast-

food restaurant?” 

Convenient Location  130 people 

Quality of Food   125 people 

Menu Selection     80 people 

Service      60 people 

Prices       40 people 

Other       65 people 

 

Create a pie chart to show the percent of each piece of the pie. 

Be sure to have a title on your chart. 

 

Line Charts 
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Excel Picture Challenge 
 

 

 

Step 1:  Click on the Sheet and check Gridlines.   Select the entire sheet by clicking on the blank cell above cell 
A1.  Then Click on the tab Format and choose row height making it 13.5. Now click on format choose 
column width and make it 2.86 

 
Step 2:   The Rainbow is Red, Yellow, Green, and Blue. 

The Tree is Green with Brown Trunk and has 8 Red apples on it  
Man has black hair, legs, feet, eyes nose.  
The shirt is orange, the pants are brown 
The arms and face are flesh color. 
Circles from drawing tool bar make hands, eyes, nose (Hint: use draw tool to make the mouth). 
Sidewalk is Gray and has a dotted line size 3 in black 
The Sun is yellow, grass is green, the sky is pale blue.  
Outline the sidewalk, grass and sky with a size 3 black straight line.  
Outline the face, arms and tree trunk with a thin black line. 

 
Step 3: Add two clouds two lightning bolts by using the auto shapes on drawing toolbar. Color the clouds dark 

gray and lightning bolts yellow. 
 

Step 4: When you are happy with the art, save it to your folder and name it “22—Smith--Excel Challenge—

10.26-17”   

Green 

Grass 

Gray  

Sidewalk 

4 Color 

Rainbow 

Tree with 

Apples 

Sun 
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1 

 

Candy is Dandy 

 
You have been hired to conduct some market research about M & M’s.  First, you had your team 

purchase 4 large bags and the results are given for the contents of those bags.  You will share your 

findings on a worksheet created in Microsoft Excel and convert the numbers into charts.   

 

Open Excel and save the blank worksheet as “Candy is Dandy” 

 

Cell What you type in the Cell How to Format 

A1 

 

Candy is Dandy Merge and Center Title across to column F, Bold, and 

change font to Red 

A3 Colors Centered, Bold, Font Color Blue 

B3 Bag 1 Centered, Bold, Font Color Brown 

C3 Bag 2 Centered, Bold, Font Color Green 

D3 Bag 3 Centered, Bold, Font Color Orange 

E3 Bag 4 Centered, Bold, Font Color Red 

F3 Average Centered, Bold, Font Color Pink 

A4 Blue Bold, Font Color Blue 

A5 Brown Bold, Font Color Brown 

A6 Green Bold, Font Color Green 

A7 Orange Bold, Font Color Orange 

A8 Red Bold, Font Color Red 

A9 Yellow Bold, Font Color Yellow 

A10 Total Center, Bold 

A11 Minimum Center, Bold 

A12 Maximum Center, Bold 

B4 6 No Formatting 

B5 4 No Formatting 

B6 3 No Formatting 

B7 7 No Formatting 

B8 5 No Formatting 

B9 4 No Formatting 

C4 9 No Formatting 
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2 

 

C5 8 No Formatting 

C6 2 No Formatting 

C7 6 No Formatting 

C8 5 No Formatting 

C9 4 No Formatting 

D4 6 No Formatting 

D5 4 No Formatting 

D6 8 No Formatting 

D7 7 No Formatting 

D8 5 No Formatting 

D9 3 No Formatting 

E4 8 No Formatting 

E5 7 No Formatting 

E6 5 No Formatting 

E7 4 No Formatting 

E8 3 No Formatting 

E9 5 No Formatting 

 

Create the following formulas 

 

1. Calculate the Average for each color.  Format the cells so that a whole number is returned.  

(no decimal places)  

2. Calculate the Total for each bag (B10, C10, D10, E10) – do not calculate average total 

3. Calculate the Minimum for each bag (B11, C11, D11, E11) – do not calculate minimum in 

the average column 

4. Calculate the Maximum for each bag (B12, C12, D12, E12) – do not calculate maximum in 

the average column 

 

Directions on how to find Average, Total, Minimum, and Maximum.   

1. Click the arrow next to your “autosum” icon.   

2. Select the appropriate command that you wish to perform 

3. Adjust the formula in the formula bar as necessary.  Be sure that your formula only calculates 

the number of M&Ms in the bags (Rows 4-9).   
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3 

 

Creating graphs  

 

You will now produce different charts and graphs that will display your data in a more visual way.   

 

The first data you will want to display graphically are the color name of the M & Ms that were found 

in bag 1.  You also want to display the actual number that was found in the bag.   

 

1. Select the color name data, place your cursor in cell A4, press the left mouse button, and drag 

to select all the cells to A9.   

2. Hold down the Ctrl key before clicking cell B4,  press the left mouse button and drag to 

select B4 to B9.  You should see that both columns are highlighted.   

3. Click the Insert Tab and click the Column Chart arrow.  Select the first chart in the 2-D 

group.  Your chart should resemble the image below.   

 

 
 

4. With the chart still selected click the Layout tab under the Chart Tools Tab.   

 

 
 

5. Use the Labels group to change the following information:  

a. Title: M & M Colors Found in Bag 1 

b. X-Axis Title: M & M Colors 

c. Y-Axis Title: Number Found 

d. Delete the 1 Legend – click on it and hit delete 

 

0

1

2

3

4

5

6

7

8

Blue Brown Green Orange Red Yellow

Series1
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4 

 

6. Change the chart location by click the Design tab on the Chart Tools tab and click Move 

Chart Icon (located all the way to the right)   

a. Chart Location- click as object in Sheet 1.   

7. Click OK 

 

 

Place the chart below your data table 

 

Create the follow charts in addition to the one above:  

 

Create your own titles for each graph 

 

Chart 2: Number of colors found in Bag 2  

   Place chart on Sheet 1 

 

Chart 3: Number of colors found in Bag 3 

   Place chart on Sheet 2 

 

Chart 4: Number of colors found in Bag 4 

   Place chart on Sheet 2 

 

Chart 5: Average compared for each colored M&M 

   Place chart on Sheet 2 

 

Chart 6: Totals compared for all bags 

   Place chart on Sheet 3 

 

Chart 7: Minimum compared for all bags 

   Place chart on Sheet 3 

 

Chart 8: Maximum compared for all bags 

   Place chart on Sheet 3 

 

Use the Insert tab and place your name in the header 
 

Staple all pages together and turn-in 

 

 

Be sure that you do not have a chart selected when you print.  If you do you 

will only print that selected chart.   
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12 DAYS OF HIGH SCHOOL 

 Microsoft Excel Project 

Take a look at these new words to a familiar holiday song:   

On the first day of High School my teachers gave to me, a locker for keeping all my stuff.   

On the second day of High School my teacher gave to me, 2 new friends and a locker for keeping all my 

stuff.   

On the third day of High School my teachers gave to me, 3 world maps, 2 new friends and a locker for 

keeping all my stuff.   

 … and so on. This pattern continues for 12 days.   

Here are the rest of the gifts: 

 4th day: 4 books to read   

5th day: 5 new textbooks  

6th day: 6 hallway passes  

7th day: 7 spelling tests 

 8th day: 8 calculators  

9th day: 9 sheets of paper  

 10th day: 10 spelling words 

 11th day: 11 hours of homework  

 12thday: 12 sharpened pencils   

 

 

Your job is to find out how much money High School can cost according to this 

song. Using Excel you will create a spreadsheet on the computer so that it will do 

all the Math. You need to show each of the 12 days and all of the items bought on 

each day. We will set up formulas for the computer to figure the cost of all of the 

12 days.  

Price List 

Lockers $28.95 each 

Friends Priceless ($0) 
World Maps $8.50 each 

Books $6.95 each 
Textbooks $36.95 each 

Passes $0.75 each 
Spelling Test $5.00 each 

Calculators $6.25 each 

Sheets of paper $.02 each 
Spelling words $2.00 each 

One hour of 
homework 

$6.50 each 

Sharpened pencils $0.25 each 
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Follow these directions for setting up your spreadsheet to calculate how expensive High school can 

be.   

1. Open Microsoft Excel. 

2.  Go to Page Layout tab -> Orientation -> Choose Landscape -> OK to change the orientation of 

the page in case you print these. 

3.  In cell A1, type your name. 

4. In cell A2, type 12 Days of High School. 

5. Skip cell A4, but starting in B4 and going across type Day 1, Day 2, Day 3 and so on until Day 12 is 

in M4. 

6. Type “#of Items” in N4. 

7.  Type “Cost per Item” in O4. 

8.  Type “Total Costs” in P4. 

9.  Starting in A5 and going down, type in the items in order that will be given by the teacher.  (i.e. 

A5 will be locker, A6 will be friends, etc.) 

10.  Then enter the quantity of each item in the appropriate cell.  (i.e. B5 will have 1 for one locker, 

C5 will have 1 and C6 will have 2 for 2 news friends and a locker, etc.)  Continue this pattern 

until you have all gifts entered. 

11.  Once all gifts are entered, we will have the spreadsheet calculate the number of items.  

Highlight cells B5-N5 and click the sum button (Σ) on your toolbar.  It should automatically 

calculate the sum of those cells and put the total in N5. 

12.  Now to copy that formula to the rest of the cells in N, select N5, then click on the small black 

circle in the lower right hand corner of the cell, hold and drag down to N16 and stop.  You 

should see the totals in the entire column now.  

13.  Enter the cost per item from your worksheet in column O.  

14.  To calculate the Total Costs, select P5 and type =N5*O5 then hit enter. 

15.  Copy this formula down the same way you did for column N.  

16.  In N18 type Grand Total. 

17.  Highlight P5-P18 and click the sum button (Σ) on your toolbar. 

18.  Now you should see the total cost of High school in P18.    
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Excel – Energy Drink Spreadsheet  
  

Objective: Create a spreadsheet that calculates the AVG, MIN, and MAX values for popular energy drinks. Format the 

cells by adjusting column and rows and applying cell styles. Include a page header and alphabetize the list.  

  

Directions:  

  

1. Open a new, blank Excel workbook.   

2. Click Page Layout | Themes and change the theme to ‘Trek’   

3. Click Page Layout | Orientation and change to ‘Landscape’  

4. Click Margins and change the margins to ‘Narrow’   

5. Enter the following data  

  

Cell A1: Popular Energy Drinks  

Cell A2: Nutritional Value  

  

Column Headings - Row 3 (Range A3:F3) Pay attention to correct capitalization and spelling. Make sure that the 

words are appearing on two lines where indicated above. To separate words on different lines, press ALT + 

ENTER before typing the word that should be pushed to the line below  

A3: Drink Name  

B3: Serving (press ALT + ENTER) Size  

C3: Calories (press ALT + ENTER) per (press ALT + ENTER) Serving  

D3: Carbs  

E3: Taurine  

F3: Caffeine  

  

Row Headings – Range A4:A12  

  

Cell A4: Red Bull  

Cell A5: Monster  

Cell A6: Rock Star  

Cell A7: Full Throttle  

Cell A8: Amp Cell A9: 5-Hour  

Cell A10: Average  

Cell A11: Highest  

Cell A12: Lowest  
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Excel – Energy Drink Spreadsheet  
6. Add the following numerical data in the cells as indicated:  

Drink Name  

Serving 

Size  

Calories  

per Serving  

Carbs  Taurine  Caffeine  

Red Bull  12  115  40  1000  120  

Monster  16  200  54  1000  160  

Rock Star  8  280  58  1000  200  

Full Throttle  8  111  29  605  72  

Amp  16  110  29  20  75  

5-Hour  2  15  3  0  139  

  

7. Apply the following formatting  

  

  A1: Merge and Center across to Column F  

  A2: Merge and Center across to Column F  

  A1:A2 Apply Cell Styles Title  

  A1: Change font size to 24-pt  

A1:A2 Use the Paint Can icon on the Home tab to apply a fill color of your choice  

  A3:F3 Apply Cell Styles Heading 3  

  A9:F9 Apply a bottom border using the Borders button on the Home tab  

  A10:A12 Bold   

  

8. Change the following Column Widths and Row Heights  

  

  Columns A:B: Width 11   

  Columns C:F Width 10  

Row 3: Height 65  

Row 10: Height 36  

  

9. Add the following formulas: (remember to use the equal (=) sign 

to begin each formula)  

  

  B10:  = AVG (B4:B9)  

Press the ‘Decrease Decimal’ button multiple times until 

there are no decimals in cell B10  

The result should be 10  
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Excel – Energy Drink Spreadsheet  
  

B11: = MAX (B4:B9)  

The result should be 16  

  

B12: = MIN (B4:B9)  

The result should be 2  

  

Select cells B10, B11, and B12  

Use the Fill Handle to copy all 3formulas across to cell F12  

  

10. Select range A4:F9 and from the Home tab, click Sort & Filter | Sort A to Z to alphabetize the list.  

  

11. Select range B3:F12 and click the Center button in the Alignment group on the Home tab to center the cells. This 

group includes the headers above the number but NOT cell A3 or the row headings (A4:A9)  

  

11. Click View | Page Layout and scroll to the top of the page to 

add a page header in the center of the page that includes your 

last name on line 1 and the course number (IBA 1) on line 2 of 

the spreadsheet.   

  

12. Click any cell except the header then click View | Normal to 

change the View back to Normal.   

13. Click Review | ABC Spelling to run the spell checker and make sure you have no spelling errors. Also, double check 

to make sure you have no capitalization errors.  

14. Save the file in your Excel folder with the proper name.  Example:   04—Mary--Energy Drinks—12.07.17  
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UUUSSSIIINNNGGG   AAANNN   EEEXXXCCCEEELLL   WWWOOORRRKKKSSSHHHEEEEEETTT   AAASSS   AAA   GGGRRRAAADDDEEE   BBBOOOOOOKKK   
 

1. Open Excel 

2. Enter the following information into and excel spreadsheet.   
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3. Type the following data for each student 

 

 
 

 

4. In cell H10 type a formula that will add all projects together to give you total points 

available for the class.  

a. Using the dragging method, insert a formula to calculate the total points earned 

for each student.   

b. Format the cell to display two decimal places.   

 

5. In cell I12 create a formula to divide student points by total points.   

a. Turn this decimal into a percent.     

b. Be sure to use absolute cell reference when creating this formula (F4 key around 

the total number of points for the class) 
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Using a Lookup table 

 

Next we will write an equation which will look at the student’s numerical average, look at a list 

of grades, and assign a letter grade to the student.  This is done with a function named LOOKUP.  

The equation must specify three elements.  

 

1. The location of the numerical grade to be compared   

2. The cell range of grading scale  

3. The location of the letter grade in the lookup table 

 

Follow the instructions below to automatically calculate the letter grades.  

1. Place your cursor in cell J12 

2. Click Insert on the Menu Bar, Click Function 

 
3. Type Lookup in the top text box and click GO,  

4. Select Lookup from the list below and click OK 
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4. Select “lookup, value, array” from the second dialog box that appears.   

 

 
 

 

5. Move the Dialog box to the side, in the Lookup_value  textbox select cell “I12” (or type 

it),  hit the tab key.   

 

6. Click in the “Array” text box, select the range for the grading scale 

 

7. Place your cursor in the middle of the Array textbox and press “F4” at the top of your 

keyboard.  This will place dollar signs in the first cell address 

 

8. Place your cursor in the middle of the B7 and press “F4” again.  

 

9. Click “OK” 

 

10. The result should be a Letter grade for the averages.   
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Your formula should resemble the following:  

 

   
 

 

After the equation is entered in cell, click and drag to fill the equation down into the remainder 

of the gradebook.   
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Spreadsheet Exercise 

Multiple Sheets & Sorting Data 

 

 

Instructions 

1.  Type in the and format the data shown above 
2. Create and name the additional worksheets as shown above (pg 166, 164) 
3. Copy and paste the data into the worksheets you created 
4. Sort the data in each spreadsheet (pg 172) 

a. By Student ID (be sure to format the column as ‘Text’) 
b. By Name 
c. By Test Score 
d. By Gender 
e. By Date Entered 
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Biography 

PowerPoint 

Presentation 
 

 
Objective:  Create a PowerPoint presentation about a person of 

significance. 
 

1. Decide whose biography you will do research on.  Your person should be 
someone who has contributed something of importance to society or 
history and has become famous because of it.  
Have this person approved! 

 
2. Create an 8-slide PowerPoint presentation about the person you have 

chosen to research. 
 

Slide 1: Introduction Slide 
 
Slide 2: Background Information 

 Where/when was this person born?  
 Childhood 
 

Slide 3: Becoming Famous 
 What did this person do for a living?  
 What qualities or traits do you believe made this person 

famous? 
 What did this person do to become famous? 
 

Slide 4: Impact on Others 
 How has this person made an impact on others’ lives? 
 In what ways was his/her life remarkable, admirable, or even 

despicable? 
 Was this person a hero? Why or why not? 
 

Slide 5: Decisions/Lessons 
 Did this person make any major mistakes or bad decisions?  
 What are some important lessons you or any other person might 

learn from the way this person lived? 
 

Slide 6: Quotes 
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 Famous quotes from this person 
 What do the quotes mean to you? 

 
 Slide 7: Other/Your choice 

 
Slide 8: Sources 
 

3. You must have pictures ON THREE SLIDES! Pictures must be clear and 
appropriate.  They must add to the purpose and design of the slides.   

 
4. Slides should be clear, easy to read, and well balanced.  

 
5. Correct spelling/grammar 

 
6. Present to class: 

 Speak clearly 
 Explain each slide thoroughly 
 Make it easy to understand 
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Colors Bag 1 Bag 2 Bag 3 Bag 4 Average

Blue 6 9 6 8 7

Brown 4 8 4 7 6

Green 3 2 8 5 5

Orange 7 6 7 4 6

Red 5 5 5 3 5

Yellow 4 4 3 5 4

Total 29 34 33 32

Minimum 3 2 3 3

Maximum 7 9 8 8
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# Student ID #Last Name First Name Score Gender Date Entered

1 0909 Collins Mike 87 M 3/14/12

2 0079 Smith Rachel 92 F 2/22/12

3 0055 Smith Adam 85 M 11/22/11

4 1763 Thomas John 67 M 9/15/11

5 0224 Johnson James 60 M 12/3/11

6 0004 John Tommy 77 M 1/8/12

7 4714 Morones Anabel 92 F 5/12/12

8 0401 Jones Sabrina 100 F 8/7/11

9 0023 Youngblood Beth 75 F 9/15/11

10 9756 Marshall Pam 95 F 3/23/12

by #89
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